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1. Pendahuluan
1.1. Game Pendidikan

Komputer saat ini sudah tidak asing lagi bagi sebagian orang. Bahkan, pada beberapa bidang kerja,
penggunaan komputer menjadi suatu keharusan untuk menunjang pekerjaan pada suatu perusahaan.
Begitu juga dalam dunia pendidikan. Karena komputer tidak dapat dilepaskan dari dunia pendidikan.
Bahkan di perguruan tinggi, ilmu komputer menjadi suatu mata kuliah yang saat ini banyak diminati
oleh masyarakat.

Oleh sebab itu, maka pengenalan komputer pada usia dini sangat diperlukan. Namun kemudian
timbul suatu pertanyaan, bagimana cara mengenalkan komputer tersebut kepada anak-anak sekolah
dasar ataupun taman kanak-kanak ? salah satunya adalah memasang sebuah aplikasi game/permainan
yang disukai oleh anak-anak pada usia tersebut. Saat ini, jika kita melihat ke sebuah toko yang
menjual game, tentu bermacam-macam jenis game yang dapat kita temukan. Namun tidak semua
game yang ada dapat menunjang apa yang diberikan di sekolah formal mereka.

Game yang berbau pendidikanlah yang sebaiknya kita berikan kepada anak-anak pada usia sekolah
tersebut, karena disamping mereka bermain, meraka juga dapat belajar komputer dan belajar
pelajaran yang mereka dapat disekolah.

1.2. Mengapa Swish

Saat ini ada banyak aplikasi-aplikasi yang dapat digunakan untuk membangun sebuah game, seperti C,
C++, visual basic dan masih banyak lainnya. Karena penulis sangat pemula dalam pembuatan game,
penulis sering mendapatkan kendala dalam membuat animasi-animasi yang akan di muat dalam game
tersebut.

Tapi saat ini telah bermunculan program-program animasi diantaranya adalah Macromedia Flash dan
SwishMax. Animasi yang dihasilkan dari program-program ini adalah berformat Flash movie (swf).
Animasi-animasinya ini lebih sering digunakan untuk movie/film, banner iklan, button, navigasi atau
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presentasi, baik dalam sebuah homepage maupun berdiri sendiri. Namun selain itu dapat juga
digunakan untuk membuat game-gamne sederhana, seperti game pendidikan yang akan dibahas pada
buku ini. Program ini dapat didownload secara gratis versi trialnya di http://www.swishzone.com
Dari beberapa program animasi yang ada, menurut penulis SwishMax lah yang paling mudah untuk
digunakan dan mungkin juga telah menarik minat banyak kaum flasher maupun web developer.
Karena, Swishmax memiliki feature yang cukup untuk menghasilkan animasi komplek yang indah,
baik animasi teks, image, grafik dan suara. Selain itu Script nya pun mudah dipelajari, karena
adanya menu guided yang disediakan untuk pemula.

SwishMax merupakan pengembangan dari Program Swish v.2, yang kini telah memiliki 230 bulit-in
efek seperti efek Explode, Vortex, 3D Spin, Snake dan banyak lainnya. Seperti halnya Swish,
SwishMax juga memilki alat bantu untuk membuat garis, kotak, elips, kurva bazier, gerak animasi,
sprite, tombol roll over dan lainnya.

Format dasar SwishMax adalah swi file, namun dapat juga diekspor kedalam file flash (swf), movie
(avi) ataupun execute(exe) program yang dapat dijalankan berdiri sendiri. Sehingga animasi
Swishmax dapat diletakkan langsung di web, atapun diikutkan dalam presentasi Microsoft Powerpint
dan Microsoft Word.

I1. Mengenal SwishMax

2.1. Spesifikasi Hardware

Program SwishMax membutuhkan beberapa klasifikasi hardware untuk dapat berjalan dengan baik.
Syarat minimun hardware yang harus dipenuhi adalah :

- Windows 95/98/NT4/2000/XP

- Pentium P2

- 64MbRAM

- Monitor 800x600 pixel dengan 256 warna

2.2. Antarmuka SwishMax

Dalam buku ini tidak akan dijelaskan secara detail tentang menu-menu dan fungsinya yang ada pada
SwishMax, tetapi secara garis besar dan hanya yang berkaitan dengan pembuatan game yang akan
dibahas pada bab selanjutnya saja.
SwishMax memiliki tampilan antarmuka/ruang kerja yang cukup bagus, yang terdiri dari beberapa
komponen, yaitu :

- Main menu

- Tollbox

- Tollbar-toolbar termasuk toolbar Standar, insert, dan control

- Panel-panel termasuk panel Timeline, Outline, Layout, dan Text

- Status Bar
Setiap komponen tersebut diatas masing-masing memiliki berbagai macam fungsi dan fasilitas yang
mendukung dalam pembuatan animasi Flash. Gambar berikut menampilkan masing-masing
komponen yang telah disebutkan diatas .
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2.2.1. Main Menu

Main Menu merupakan menu utama dari SwishMax, karena didalmnya terdapat menu-menu yang
akan sering kita gunakan. Main menu terletak dibagian paling atas dari window SwishMax.
Menu-menu ini juga dapat diakses melalui tollbar-toolbar yang ada.

Menu-menu yang terdapat pada main menu adalah :

a.File

Menu file memiliki beberapa submenu, diantaranya :
-0 New (Ctrl+N) : digunakan untuk membuat movie baru

~u

- L= Open (Ctrl+0O) : digunakan untuk membuka file .swi (movie Swishmax) atau file-file

format lain tapi masih didukung oleh SwishMax.
. H Save (Ctrl+S) : digunakan untuk menyimpan movie yang sedang aktif

. B Save As : digunakan untuk menyimpan movie yang aktif dengan nama baru
- Export : digunakan untuk mengexpor movie SwishMax menjadi file .swf, movie(.avi),
file .html dan file execute (.exe).

Selain submenu diatas masih banyak ada menu-menu lainnya yang dapat dipelajari dan dicoba
sendiri.

b.Edit

Menu Edit memungkinkan kita melakukan editing/perubahan pada suatu movie.
Submenu dari menu edit antara lain :

Copy : digunakan untuk meng-copy object atau efek yang dipilih ke clipboard
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Paste : digunakan untuk men-paste object atau efek dari Clipboard ke movie
SwishMax yang sedang aktif

- ¥ Delete : digunakan untuk menghapus object atau efek yang sedang dipilih
c.View

Menu View berisi fasilitas untuk mengubah tampilan movie, mengatur tollbar yang ditampilkan,
menampilkan grid dan sebaginya. Menu View memilki submenu antara lain :

A Zoom In : digunakan untuk memperbesar tampilan pada panel layout

K Zoom Out : digunakan untuk mempekecil tampilan pada panel layout

- 2 Fit Scene In Window : digunakan untuk menampilkan supaya scene tampak
semuanya/mencukupi pada panel layout

d. Insert

Menu Insert digunakan untuk menambahkan suatu objek kedalam movie, baik berupa text, button,
sprite dan lainnya. Selain objek, melalui menu ini juga efek dan Script ditambahkan kedalam objek
atau movie. Submenunya antara ain :

- B Scene : untuk menambahkan scene baru kedalam movie

- T Text : digunakan untuk menyisipkan teks kedalam scene/sprite/group.

.Y Button : digunakan ntuk menambahkan button/tombol kedalam scene/sprite/group.
. o Sprite : digunakan untuk menyisipkan sprite kedalam scene/sprite/group.

- =& Image : digunakan untuk menyisipkan image/gambar kedalam scene/sprite/group.
- m¥ Content : untuk menyisipkan file eksternal kedalam movie. Perintah ini sama dengan perintah
File > Import

Effect : igunakan untuk menambahkan efek pada objek yang dipilih. Efek yang tersedia cukup

banyak pada SwishMax, dan dapat langsung dilihat.

- Seript : digunakan untuk menambahkan script/ perintah pada suatu objek atau pada frame yang
dipilih. Script disini dapat berupa Event, Action atau Difine Functions. Script yang
telah dibuat dapat diedit pada Panel Script (berbentuk “tab” berdampingan dengan
Layout”

e. Modify

Menu ini menyediakan fasilitas untuk melakukan perubahan pada property dari satu objek. Menu
yang paling sering nanti digunakan adalah :
- Grouping :
- Group as Group : digunakan untuk menjadikan sekelompok objek menjadi satu group.
Efek komplek dapat diaplikasikan ke group
- Group as Button : untuk menjadikan sekelompok objek yang dipilih menjadi suatu
Button/tombol.
- Group as Sprite : untuk menjadikan sekelompok objek yang dipilih menjadi suatu sprite.
- Group As Shape : untuk menjadikan sekelompok objek yang dipilih menjadi sebuah
shape.
- Ungroup : untuk memecah group atau sprite menjadi objek terpisah.
- Convert :
- Convert to button : untuk mengkonversi suatu objek menadi sebuah button
- Convert to Sprite : untuk mengkonversi suatu objek mendjadi sebuah sprite

f. Control
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Menu Control menyediakan fasilitas bagaiman movie terseut akan dimainkan dandi preview.
Submenunya antara lain :

- » Play Movie : Memainkan movie secara keseluruhan
_E Play Timeline : untuk memainkan Scene atau Sprite yang sedang aktif
[
- % Play Effect : untuk memainkan bagan dari Scene yang mengandung efek yang dipilih

. Stop : untuk menghentikan movie, scene, atau efek yang sedang dimainkan.
2.2.2. Toolbox

Toolbox merupakan sekelompok tombol-tombol sebagi alat bantu yang diletakkan dalam suatu area
yang akan digunakan untuk menghasilkan suatu objek. Tollbox secara default teretak paling kiri dari
Panel Layout .Tool yang ersedia antara lain :

- R Select : untuk memilih, memindahkan atau menskala objek dengan cara mengklik dan
men-drag objek yang dipilih.

- % Reshape : untuk membentuk ulang grafik cara mengklik dan men-drag objek yang
dipilih.
- Fill transporm : untuk mentrasformasi gradient atau image fill tanpa merubah objek

- =” Motion Path : untuk memplot jalur gerak dari suatu objek dengan cara mengklik dan
men-drag objek yang dipilih.
-/ Line : untuk menggambar garis

. Pencil : untuk menggambar bebas

. b Bezier : untuk menggambar set dari kurva bazier atausegemen garis

.

- ikl Text: untuk menambahkan teks pada movie

. O Elipse/Circle : untuk menggambar elips atau lingkaran

- u Rectangle/Square : untuk menggambar kotak/kurva

. 9 Auto Shape : untuk menggambar objek dengan bentuk-bentuk tertentu seperti gambar

berikut :

VA= e
wOmO0

2.3. Elemen Dasar SwishMax
2.2.1. Movie

Sebelum kita belajar lebih jauh tentang pembuatan game dengan SwishMax, perlu kita ketahui dulu
elemen-elemen dasar dari sebuah animasi Flash yang dibentuk dari SwishMax. Hal pertama yang arus
kita pahami adalah animasi yang dibuat dengan SwiahMax akan kita sebut dengan movie. Sedangkan
movie itu sendiri terdiri dari satu atau lebih scene, dan setiap scene memiliki satu atau lebih timeline.
Timeline adalah kumpulan beberapa frame. Dari setiap timeline dari sebuah scene dapat kita tepatkan
objek, dan objek itu dapat pula kita beri efek. Efek-efek akan mulai dan berhenti pada frame tertentu
dan dapat dikontrol melalui Script.

Untuk membuat sebuah movie baru, kita tinggal menekan tombol File > New atau menekan
bersamaan tombol CTRL dan tombol N.

2.2.2. Scene



Kuliah Berseri [ImuKomputer.Com
Copyright © 2005 IlmuKomputer.Com

Scene adalah kumpulan dari beberapa objek yang telah diberi efek-efek tertentu dalam sebuah
timeline. Scene baru dapat dibuat dengan menekan tombol Insert > Scene. Untuk menambahkan
sebuah objek ke dalam Scene, kita cukup menekan salah satu objek yang ada pada Tollbox, kemudian
klik atau drag pada Layout Panel dimana kita akan menempatkan objek tersebut.

2.2.3. Timeline dan Frame

Seperti halnya sebuah film biasa, Scene terdiri atas beberapa buah frame yang akan berjalan berurutan
ataupun tidak yang dapat dikontrol melalui perintah pada panel Script. Sedangkan Timeline
merupakan kumpulan dari frame-frame, yang dimulai dari frame sebelah kiri dan berakhir pada frame
sebelah kanan. Untuk lebih jelasnya perhatikan gambar berikut :

| P|1||||5 ||||| 1 I:llll
& Scene_1

et
& Shape

Fade In [10]

Baris teratas merupakan frame events yang berhubungan dengan action-action pada scene Contoh
diatas adalah Scene 1. Sebuah action akan dijalankan bila movie telah sampai pada frame-frame
tertentu. Dalam satu frame biasanya terdapat satu atau lebih action.

Sedangkan baris-baris dibawahnya merupakan frame yang berhubungan dengan objek-objek yang
ada pada Scene. Baris-baris tersebut ditampilkan dalam urutan tertentu, dimana obyek yang lebih
diatas akan tampil lebih diatas dalam tampilan pada layout. Seperti contoh diatas, obyek “text” akan
tampil diatas obyek “Shape”, begitu seterusnya jika ada obyek-obyek dibawahnya.

2.2.4. Object
Dalam Swishmax dikenal ada dua obyek, yaitu Obyek Sederhana dan Obyek Komplek

Obyek Sederhana
Obyek sederhana hanya mengandung sebuah elemen/elemen tunggal. Obyek sederhana dalam
SwishMax meliputi :

- Shape Objects

- Button Objects

- Sprite Objects

- Instance Objects

- Text Objects (input, dynamic dan static dimana “Target” dicentang)

- Groups Objects (yang diberi nama dan “Target” dicentang)

- Sound Objects

Obyek Komplek
Obyek komplek terbuat dari beberapa shape. Obyek ini meliputi :
- Text Objects (statics dan “Target” tidak dicentang)
- Groups Objects ( yang tidak diberi nama atau “Target” tidak dicentang)

2.2.5. SwisHscript

SwisHscript merupakan pengganti dari Panel Action pada Swish v.2. SwisHscript adalah bahasa
yang digunakan dalam SwisHmax untuk memprogram sebuah movie dan item-itemnya dalam sebuah
movie. SwisHscript dapat digunakan untuk :
- mendifinisikan Action-action yang akan terjadi pada suatu frame tertentu, ketika dua buah
obyek bertemu/bertabrakan, atau ketika kita akan meng-input variable dari file external.
- Mengontrol dalam pemakain suara/sound
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- Berinteraktif dengan file-file external seperti PHP, ASP ataupun Text
- Untuk menifinisikan property fisik dari sebuah obyek dan lain-lainnya

SwisHscript inilah bagian yang sangat penting dan menarik dari SwisHmax, karena dengan adanya
script ini banyak yang dapat kita lakukan seolah-olah kita sedang menggunakan suatu bahasa
pemrograman. Ada dua mode yang diberikan , yaitu mode “Guide” yang menampilkan action-action
yang umum dan sering digunakan, dan mode “Expert” yang semua action diketik sendiri. Untuk
pemula lebih baik menggunakan mode guide.
Seperti halnya dalam suatu bahasa pemrograman, SwisHscript juga mengenal istilah yang kita sebut
dengan “variable”. Variabel biasanya digunakan untuk menyimpan suatu nilai, baik berupa masukan
ataupun nilai keluaran/hasil, seperti contoh berikut :

x=3+1
maka varibel “x” akan tersimpan dengan nilai (3+1) atau 4. Jika kita lihat contoh berikut :

y=x*x /ly=16

x=x+1 // x =5, dmana nilai x sebelumnya adalah 4
Perlu diperhatikan, dalam SwisHscript tanda // digunakan sebagai area komentar.
Variabel juga dapat digunakan untuk menyimpan nilai berupa teks (variable string) seperti contoh
berikut :

Pesan = “selamat pagi” // pesan= “selamat pagi”

2.2.5.1. Events

Ada beberapa hal yang perlu dipelajari dari scripting ini yaitu tentang Event dan Actions. Semua
Actions dibangkitkan dari sebuah Event. Event dapat terjadi ketika movie mencapai suatu frame
tertentu, respon dari mouse ataupun keyboard. Sebuah Event dapat memicu lebih dari satu actions.
Untuk meudahkan pemahamannya kita contohkan sebagai berikut : Ketika movie mencapai sebuah
frame atau ketika mouse melewati suatu obyek (event), movie berhenti (Actions Stop) dan
memainkan sebuah .mp3 file (actions play sound). Untuk menambahkan Frame events pada suatu
movie, pilihlah frame dari sebuah obyek, kemudian pilih tab “Script” pada “Panel Layout”, klik
kanan dan pilih Add Script > Events > Frame seperti gambar berikut :

Add Script Frame
Define functiond...) Button

Self

Text

v v v v

Frame

Movie Control
Conditional
Mouse Dragging
Sprites
Statements
Sound

Browset fhetwork
Debugging

*r rF rFT T OwT T T YT

Ada empat tipe dari events, yaitu :
- Frame Events : terjadi ketika movie mencapai frame tertentu, diantaranya adalah :
a. onFrame : Event akan dijalankan saat sebelum frame tertentu.
b. onLoad : Event akan dijalankan ketika Sprite atau Scene dijalankan pertama
kali.
c. onEnterFrame : event akan dijalankan pada setiap frame yang dilalui
- Self Events : terjadi ketika mouse berinteraksi dengan sebuah objek atau saat menekan
sebuah tombol pada keyboard. Hanya obyek yang didefinisikan sebagai target (‘“Target”
dicentang) yang dapat menggunakan event ini. Macam-macan event ini adalah :
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g.
h.

Press [] Drag aver

[]Beleaze [ Dragout

[JRellaver [ Release outside

[] Rall put Ky w

onSelftEvent (press) : menekan klik kiri mouse saat kursor diatas obyek
onSelftEvent (release) : melepaskan tombol kiri mouse saat kursor diatas
obyek

onSelftEvent (roll over) : memindahkan kursor mouse dari luar obyek ke atas
obyek tanpa menekan mouse

onSelftEvent (roll out) : memindahkan kursor mouse dari obyek ke luar obyek
tanpa menekan mouse

onSelftEvent (drag over) : memindahkan kursor mouse dari luar obyek ke atas
obyek dengan kondisi tombol kiri mouse ditekan

onSelftEvent (drag out) : memindahkan kursor mouse dari obyek ke luar
obyek dengan kondisi tombol kiri mouse ditekan

onSelftEvent (release out) : melepaskan tombol kiri mouse setelah
memindahkan kursor keluar dari obyek

onSelftEvent (keypress) : saat tombol pada keyboard ditekan.

- Button Events : terjadi ketika mouse berinteraksi dengan sebuah objek atau saat menekan
sebuah tombol pada keyboard. Penambahan Button Event pada sebuah obyek akan membuat
obyek tersebut diperlakukan seperti sebuah Button/tombol.

Events ini mirip sekali dengan Selt Event, sehingga penulis tidak mendiskripsikannya
satu-persatu lagi.

- Text Event yang hanya terdiri dari satu event yaitu “onChange”, berlaku jika ada

perubahan pada suatu text.

2.2.5.2. Actions

Actions adalah sebuah perintah yang dipicu oleh sebuah event. Action dapat mengubah permainan
dari movie, memainkan atau menghentikan suara/sound, memanggil movie atau halaman web lain,
atau berkomunikasi dengan browser host atau player. Property Action berada bersamaan dengan
Event, dengan mengklik kanan tombol mouse pada sebuah event.

Berikut adalah action-action yang ada pada mode Guide yang akan digunakan dalam pembuatan
game pada bab berikutnya, antara lain :

Stop : digunakan untuk menghentikan movie atau sprite yang sedang dimainkan.

Goto and Play : digunakan untuk menuju frame tertentu. Frame ini dapat berada dalam
scene yang sama, scene lain atau dalam sprite.

Target |Scene_1 b

{*) Frame 1
) Label
© Skip
And: (®) Play () Stop

Gambar diatas menunjukkan bahwa movie akan diteruskan ke Frame 1 pada Scene 1.
If : digunakan untuk mengecek suatu varibel yang bernilai true atau false.
Else : mengeksekusi alternative statement dari action If
For : adalah sebuah perintah pengulangan yang bersyarat. For memiliki tiga elemen, yang
pertama menyatakan kondisinya, yang kedua adalah syarat yang akan dieksekusi, dan yang
ketiga adalah pengulangannya.
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Add Script + 4 & ¥§ Guided ~

onFrame (1) {

trace (i) ;

o 1

fc:r[|j_=0 |;

i<5 |:[ac

|i++ |]

[(Jforf.in..]

Gambar menunjukkan akan terjadi pengulangan dari nilai 0 sampai 4 dengan penambahan 1.
Maka hasil pada debug windows adalah “0,1,2,3,4” (trace (i) digunakan untuk menuliskan output
pada debug window)

- Evaluate : digunakan untuk menentukan suatu nilai dari sebuah variable
- Name = expr : digunakan untuk mengubah property dari suatu obyek.

Add Scipt 4 4 ¥§ Guided v

onFrame (5) {

MySprite. X += 10;

Target: |[MpSprite b |
MName: |_# | b

I:Iperah:ur:[+= [add ar plusz] "]

10

Action diatas akan menambah 10 pixels sumbu X dari obyek “MySprite”

- loadVariableNum : digunakan untuk membaca data dari external file, seperti asp, php
ataupun file text.
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Layout : Scene 1| Script |

Add Script + 4§ ¥§ Guided -

on (press) [

loadVariablesMuw ("text _txt" 0} ;

H

JRL: "| bt bk

Load into: [Level A
Lewvel: |III|

Yariables: [Don't send vaniables  * |
Load variables only

Action diatas akan memanggil file “text.txt“ untuk digunakan dalam movie. Perlu
diperhatikan, jika akan membuat file .txt, format agar dapat digunakan oleh SwisHscript adalah
diawali dan diakhiri dengan tanda “&”. Misalnya kita membuat variable
&nama=nyoman&alamat=bali& dan seterusnya.

Masih banyak sekali action-action yang tidak dapat ditampilkan disini secara keseluruhan, seperti

fungsi-fungsi matematika, obyek property dan lainnya yang beberapa akan dijelaskan dalam
bab-bab berikutnya.

Bersambung ......

(L)&(L)
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